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Marine Reserve and MPA Boundaries for Navigation Programs and Plotters
The .zip file package includes electronic files for downloading boundaries for Oregon’s five marine reserve
and nine Marine Protected Area (MPA) sites onto your boat’s navigation system/plotter. ODFW has worked
with the Oregon Fishermen’s Cable Committee (OFCC) to make these boundaries available to download for
the most commonly used navigation software programs. The electronic files also include locations of OFCC
undersea cable routes, which you have the option to download for some programs.
Following, you will find paper instructions on how to download the boundaries for each navigation program
once you have downloaded and unzipped the .zip file package onto a thumb drive (USB flash drive). We
have also enclosed paper copies of summarized harvest restrictions and maps for each site.
For use with the following programs:
• Maptech Offshore Navigator
• Rose Point Coastal Explorer
• Nobeltec Visual Navigation suite/Odyssey Time Zero
• OLEX
• P-Sea WindPlot II
Marine reserve and MPA harvest restrictions begin:
• Jan 1, 2016: Cape Falcon
• Already in effect: Cascade Head, Otter Rock, Cape Perpetua, and Redfish Rocks
Disclaimer:
Routes, boundaries, and marks provided on this thumb drive are for summary purposes only. These overlays
were created using coordinates from OAR 141-142, but ODFW is not responsible for the positional accuracy
of the boundaries of the marine reserves and MPAs including any coordinates or other location files. Our
summary of the regulations does not replace the official regulatory language adopted by the Oregon Fish and
Wildlife Commission, and found in the Oregon Administrative Rules (OARs). Three state agencies have
jurisdiction over marine reserves, and the rules may change. Consult the text of the current regulations in
OAR 635-012 for rules by ODFW, OAR 141-142 for rules by the Division of State Lands, and OAR 736-029
for rules by the Oregon Parks and Recreation Department to be certain what rules apply. Provided paper maps
are for summary purposes only. Please consult the current fishing regulations.
Report violations: Please call Oregon State Police at (800) 452-7888
Questions: Please call the ODFW Newport Office at (541) 867-4741

Maptech Offshore Navigator© Data Loading Instructions
(These instructions were written for Offshore Navigator version 5.08. Other versions may have a slightly
different procedure.) These instructions are just a guide, for issues downloading consult your electronics
expert.
1. Open the Maptech Offshore Navigator program.
2. Back up your existing fishing data to the hard drive or an external drive (recommended).
3. Insert flash drive into a USB port on the computer. If a new window opens on top of the Maptech
Offshore Navigator program, note the letter designating the drive and then close the new window. The
data will be loaded through the Offshore Navigator program.
4. In the upper left corner, left click on “File” to open the dropdown menu.
5. Highlight “Import Data from File…” and left click. The “Import Data from File” window will open.
6. The “Origin of Data” cell should read “Offshore Navigator 4.x/5.x. If this is not displayed, select from
the dropdown menu using the down arrow at the right side of the cell. This data is in Offshore
Navigator Version 5.08 format.
7. Left click on the “Browse” button. A new window called “Maptech Select Directory from which to
Import Data” will open. First, go to the “Drives” cell on the bottom of the pane, and using the
dropdown menu arrow on the right of the cell, select the flash drive just inserted. Left click on the
selected drive.
8. In the “Folders” window, select the folder “Offshore Navigator” and left click “OK”.
9. The “Import Data from File” window will reappear. Left click on “Import…”. The “Import Routes”
window will open with the Marine Reserve and Marine Protected Areas listed. Left click on the “Import
All” button.
10. Move your screen to the areas of the Marine Reserves to confirm that the marine reserves and marine
protected areas are being displayed. Once you confirm that the marine reserves are displayed, you can
remove the flash drive. In the lower right corner of your monitor look for the icon that says, “Safely
Remove Hardware …”. If found, click on this with your left trackball button or left mouse button.
Select the flash drive to eject. You may remove the flash drive.

Rose Point Coastal Explorer© Data Loading Instructions
(These instructions were written for Coastal Explorer version 2009. Other versions may have a slightly
different procedure.) These instructions are just a guide, for issues downloading consult your electronics
expert.
1. Open the Coastal Explorer program.
2. Back up your existing fishing data to the hard drive or an external drive (recommended).
3. Insert flash drive into a USB port on the computer. If a window opens, note the letter
designating the drive and then close the window. You will load the data from within the
Coastal Explorer program.
4. Using your trackball or mouse move your cursor to the “File” menu in the upper left corner
and click the left button. A menu will drop down. Select “Import…”.
5. The Import Navigation Objects window will open asking where to import the navigation
objects from. Left click on the small button “Some other file on My Computer” then left
click on the “Select File…” button. A new window will open. Locate the flash drive from
the list. Select the flash drive that was plugged in. (#2 above).
6. Move your cursor over the file folder named “Coastal Explorer” and open it. Then move
your cursor over the file “ODFW Coastal Explorer MR-MPA” and click the left button to

select it. Move your cursor to the “Open” button in the lower left of the window and left
click.
7. The Oregon marine reserves and marine protected areas should be shown on your display.
Move your chart to an area of a marine protected area to confirm that the data has loaded.
The Marine Reserves will be shown in red; the Marine Protected Areas will be shown in
blue.
8. In the lower right corner of your monitor look for the icon that says, “Safely Remove
Hardware …”. Click on this with your left trackball button or left mouse button. Select the
flash drive to eject. You may remove the flash drive.

Nobeltec Visual Navigation Suite© Data Loading Instructions
(These instructions are based on Nobeltec VNS version 7.1.900. Other versions may have a slightly different
procedure.) These instructions are just a guide, for issues downloading consult your electronics expert.
1. Open the Nobeltec Program.
2. Back up your data to the hard drive and/or an external flash drive (recommended).
3. Insert flash drive into a USB port on the computer. If a window opens, note the letter
designating the drive and then close the window.
4. Open the “File” menu in Nobeltec, select “Navigation Objects”, then move your cursor to
the right to see the choices. Select “Import Objects…”. The Import Navigation Objects
window opens with the default file directory of your hard drive. Select the “Browse” button,
pull down the menu expansion button (downward pointing triangle) to the right of the
Nobeltec Community folder. A menu will expand down. Select the drive with the ODFW
flash drive.
5. Select the file shown – “ODFW Nobeltec MR-MPA”.
6. Click on “Open”.
7. The Import Navigation Objects window returns, with your selected file and drive shown. Click
on the “Import All” button.
8. Click on the “OK” or “Done” button (This is important!).
9. The marine reserves and marine protected areas should be shown on your display, with the
reserves showing up red, and the marine protected areas showing up as blue. Move your
chart to an area of a marine protected area to confirm that the data has loaded.
10. In the lower right corner of your monitor look for the icon that says, “Safely Remove
Hardware …”. Click on this with your left trackball button or left mouse button. Select the
flash drive to eject. You may remove the flash drive.

OLEX Data Loading Instructions
New versions of OLEX will have a “Storage Device Detected” window open automatically when the flash
drive is plugged in. Select the “Read from USB 2.0 Flash Disk” From the menu that opens double left click
on the Nobeltec-OLEX folder. Select either the ODFW Nobeltec MR-MPA.txt file for Oregon Marine
Reserves and Marine Protected Areas, or the file: DDFW Nobeltec MR-MPA + OFCC Cables.txt to install
both the OR Marine Reserves/Marine Protected Areas and the OFCC cable routes. A window will open that
asks you to confirm that you really want to read the Nobeltec plotter data. Click on Yes. A window will open
that asks you, “How the imported plotter objects should be organized? You can select a layer by clicking on
one of the letters, A-H. These instructions are just a guide, for issues downloading consult your electronics
expert.
In both older versions and newer versions of OLEX you can load the data from the Settings menu:

1.
2.
3.
4.
5.
6.
7.

Open the OLEX program. Back up your existing fishing data (recommended).
Insert flash drive into a USB port on the computer.
Open the “Settings” menu.
Click on the box to read data and software.
Select the flash drive just inserted.
Select the Nobeltec-OLEX folder.
Select the file you wish to load to the plotter: For Oregon Marine Reserves and Marine
Protected Areas select the file: ODFW Nobeltec MR-MPA.txt; for Oregon Marine
Reserves, Marine Protected Areas and OFCC cable route information, select the file: DDFW
Nobeltec MR-MPA + OFCC Cables.txt
8. Confirm that you want to read the Nobeltec plotter data
9. Select the data layer where you want to put the data, such as A, B, C etc. Click OK.
P-Sea WindPlot II© Data Loading Instructions
(These instructions are written for P-Sea WindPlot II version 7.25.10. Other versions may have a slightly
different procedure.) In the newest P-Sea WindPlot II ver. 7.27.3, the process is similar but the boundaries
are imported by selecting Fishing Boundaries under the Options menu on the top bar.
These instructions are just a guide, for issues downloading consult your electronics expert.
1. Open the P-Sea WindPlot program.
2. Back up your existing fishing data to the hard drive or an external flash drive
(recommended). If you have existing boundaries on your plotter, we also recommend that
you back up those boundaries before you install the Marine Reserve/Marine Protected Area
boundaries.
3. Insert the flash drive into a USB port on the computer. If a new window opens on top of PSea WindPlot, note the letter designating the drive and then close the new window-- you
will load the data through the P-Sea WindPlot program.
4. Move your cursor to the upper left corner over the Marks menu (to the right of the Data
menu) Left click on this to expand the menu down. Select Boundary Builder with your
cursor and left click. The “Boundaries” window will open.
5. In the lower left corner of the Boundaries window, left click on the downward pointing
triangle to see the available drives. Select the letter corresponding to the flash drive that was
just plugged in.
6. Left click on the “Get” button also located in the lower left portion of the Boundaries
window. The names of the Marine Protected Areas and Marine Reserves will be added to
the end of the list of your Boundaries.
7. In the Display Options area, make sure the “Boundary ON” box is checked so your
Boundaries are shown. It is not necessary to have the “Node #’s ON” box checked. Click
“EXIT” to close this window.
8. Move your screen to the areas of the Marine Reserves to confirm that the marine reserves
and marine protected areas are being displayed. Once you confirm that the marine reserves
are displayed, you can remove the flash drive. In the lower right corner of your monitor look
for the icon that says, “Safely Remove Hardware …” Click on this with your left trackball
button or left mouse button. Select the thumb drive to eject. You may remove the thumb
drive.

MARINE RESERVES AND MARINE PROTECTED AREAS
This summary does not replace the official regulatory language found in OAR 635-012
Marine Reserves: No take of any fish, invertebrates, seaweeds, or wildlife. Persons may have catch
onboard while transiting or anchoring in the marine reserve. Persons may take fish and wildlife species if
authorized under a valid scientific take permit. Fishing gear shall not be deployed in the water at any
time within the marine reserve area, except as allowed under a valid scientific take permit. Fishing gear
may be removed from these areas provided the retrieving skipper notifies Oregon State Police (1-800452-7888) and receives permission in advance. No fish or wildlife species from the retrieved gear shall
be retained. Specific to crab pots, the vessel operator may re-set pots belonging to the retrieving vessel
outside of the reserve area. If the pots do not belong to the retrieving vessel, the vessel operator must
follow the retrieval requirements set forth in the Derelict Dungeness Crab Gear rules.
Marine Protected Areas (MPAs): Site specific harvest and/or gear restrictions apply at each MPA. See site
specific MPA rule summaries in the sections that follow. It is unlawful to fish for or take any legal species
in the MPA while possessing onboard any species not allowed to be taken in the MPA or Seabird
Protection Area.

MAPS and RULES SUMMARIES
for Cape Falcon, Cascade Head, Otter Rock, Cape Perpetua, and Redfish Rocks
The following are summaries of the commercial fishing rules for each Marine Reserve and MPA (sites are
listed from north to south).

Cape Falcon
Marine Reserve:
Shoreside MPA:
West MPA:
Shoreline:

No take of any fish, invertebrates, seaweeds, or wildlife. No fishing gear deployed.
No commercial take (some sport fishing is allowed)
Take of salmon (by troll) and crab is allowed. All other take is prohibited.
Take above the low tide line is severely restricted along rocky shores south of the
Shoreside MPA (e.g. no take of mussels or seaweeds).
Point
A
B
C
D
E
F
G
H

Latitude
45°48.00’
45°46.80’
45°44.00’
45°44.00’
45°48.00’
45°44.00’
45°44.31’
45°48.00’

Longitude
-123°58.10’
-123°58.17’
-123°56.77’
-124°01.50’
-124°01.50’
-124°03.19’
-124°03.50’
-124°03.50’

Cascade Head
Marine Reserve: No take of any fish, invertebrates, seaweeds, or wildlife. No fishing gear deployed.
North MPA:
Take of salmon (by troll) and crab is allowed. All other commercial take is prohibited
(some additional sport fishing is allowed).
West MPA:
Take of salmon (by troll) and crab is allowed. All other take is prohibited.
South MPA:
Use of net gear is prohibited. All other legal take is allowed.
Shoreline:
Take above the low tide line is severely restricted along rocky shores in the North MPA
and on the north end of the Marine Reserve (e.g. no take of mussels or seaweeds).
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Point
A
B
C
D
E
F
G
H
I
J

Latitude
45°02.00’
44°59.25’
44°59.25’
45°02.00’
45°02.00’
45°05.00’
45°05.00’
44°56.50’
44°56.50’
44°59.25’

Longitude
-124°00.52’
-124°00.89’
-124°04.50’
-124°04.50’
-124°05.00’
-124°05.00’
-124°00.40’
-124°01.47’
-124°05.00’
-124°05.00’

H

Otter Rock
Marine Reserve: No take of any fish, invertebrates, seaweeds, or wildlife. No fishing gear deployed.
Shoreline:
Take above the low tide line is severely restricted along rocky shores (e.g. no take of
mussels or seaweeds).
Point
A
B
C
D

Latitude
44°45.17’
44°43.31’
44°43.31’
44°45.17’

Longitude
-124°03.86’
-124°03.66’
-124°04.20’
-124°04.53’

Cape Perpetua
Marine Reserve: No take of any fish, invertebrates, seaweeds, or wildlife. No fishing gear deployed.
North MPA:
Take of salmon (by troll) and crab is allowed. All other commercial take is prohibited
(some additional sport fishing is allowed).
Southeast MPA: Use of trawl gear is prohibited. Take of herring, sardine, anchovies, smelt, sand lance,
and market squid is prohibited. All other legal take is allowed.
Seabird Protection Area: Take of herring, sardine, anchovies, smelt, and sand lance is prohibited. All other
legal take is allowed.
Shoreline:
Take above the low tide line is severely restricted along rocky shores in the North MPA
and in the Marine Reserve north of Bob Creek (e.g. no take of mussels or seaweeds).
Point
A
B
C
D
E
F
G
H
I
J
K

Latitude
44°17.00'
44°13.50'
44°13.50'
44°17.00'
44°17.00'
44°20.00'
44°20.00'
44°05.75'
44°05.75'
44°13.50'
44°05.75'

Longitude
-124°06.73'
-124°06.74'
-124°11.00'
-124°11.00'
-124°10.50'
-124°10.50'
-124°06.04'
-124°07.53'
-124°08.60'
-124°08.00'
-124°11.62'

Redfish Rocks
Marine Reserve: No take of any fish, invertebrates, seaweeds, or wildlife. No fishing gear deployed.
MPA:
Take of salmon (by troll) and crab is allowed. All other take is prohibited.
Shoreline:
Fishing from shore is prohibited. The shoreline is not included in the marine reserve,
therefore take above the low tide along the shore is allowed (e.g. clamming is allowed).

Point
A
B
C
D
E
F

Latitude
42°42.96’
42°41.52’
42°41.16’
42°42.54’
42°40.25’
42°41.90’

Longitude
-124°27.78’
-124°27.18’
-124°28.86’
-124°29.64’
-124°32.50’
-124°32.50’

